Owner’s Manual – Revision 1.5
for
µSC ‘Micro String Controller’ Version 1
Basic, Optioned and Mega Versions*

*Note – Basic controllers originally supplied with no LEDs and no magnetic reed ‘Test’ switch. Optioned
controllers could have various combinations of LEDs in various colors, magnetic reed switch and/or ICSP
header. Mega µSC’s originally supplied with four ‘standard’ LEDs and magnetic reed switch installed. All
references to these components in the following documentation are on an ‘as applicable’ basis.
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Foreword
The µSC or ‘Micro String Controller’ was designed from the ‘board up’ to offer advantages in cost and
extended performance which have not been available to the hobbyist community before. Some of the
features incorporated into this board are detailed below:
‐ Optimized design to get board small as practical
‐ Uses all SMT on the basic board for small size, cost effective components
‐ Selected components optimized for the job. Cold weather operation, data transmission capability,
MOSFET driver, ESD protection, etc
‐ Comes ready for installation and channel programming (no board assembly needed), just attach wires
and go
‐ Flat board with no contact/ICSP pins easy to waterproof in heat‐shrink tubing.
‐ All strain relief holes big enough for the 3‐4 pin connectors on the market, bundled Cat5, or most any
other wire you need
‐ 3.3V RS485 receiver, fully compatible with PIC chip, 14KV ESD protection on input
‐ On board voltage regulators provide self‐regulating / auto shutdown overload protection.
‐ Large value filter capacitors insure sufficient smoothing even when capacitance drops due to cold
weather
‐ MOSFET driver output section: Schmitt triggered, ESD and short circuit protected, true push‐pull
output for solid data transmission through long wires. (Not recommended, but bench tested for weeks
with 90 foot µSC‐to‐first‐node distance)
‐ Upgrades are configured to not add any additional cost to the basic board. Upgrades can be
completed with simple through‐hole soldering (LEDs and ICSP header) or simple surface mount
attachment (magnetic reed switch)
‐ Robust design, generally tolerant of ESD / static discharge, shorting data out to up to 16V or ground.
‐ Optional LEDs provide easy troubleshooting / observation of various functions.
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1. Typical Application

Revision 1.5 – 8/15/2014

Back to Contents

µSC Layout and Features
Front / Component Side

Rear / Solder Side

2
2. Adding Optional Components
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Items and Tools Required to Install Optional Components
The µSC was designed so all optional components can be installed with a typical set of hobbyist
electronic tools. A list of required tools as well as some optional equipment is detailed below:
(I have purposely tried to avoid recommending specific brands or equipment)

Minimum Requirements
Wire Stripper – Used to strip insulation from Cat 5, Node Wires, etc before attaching to the board.
Solder – Typically, “60/40” rosin core solder approximately 0.031” diameter works well at this scale of
assembly. Other alloys could also be used as could solid solder with separate flux, etc.
Soldering Iron – A simple/typical hand held iron will work fine in this application. A long/thin tip is
recommended to aid access in tight spaces of the board, such as around the LED lead area. Various
‘soldering stations’ can also be used.
Soldering Iron Tip Cleaner – Some method to clean excess flux from the soldering iron tip. This can be
as simple as a wet, lint free towel, wet non‐synthetic sponge, etc. A brass ‘brillo‐pad’ can also be used
and has the advantage of pulling excess solder off the tip of the iron.
Diagonal / Side Cutters – Used to trim excess leads from LEDs after soldering. I recommend a pair
which can trim very close to the circuit board. Some ‘diagonal cutters’ for general shop use have a large
bevel at the cutting edge and can only trim to within ~1/8 inch from the board.
Flux Cleaner – Some fluxes can be left in place after soldering, however it is always good practice and a
nicer appearing job to remove the flux when soldering is finished.

Optional Accessories –
Sand Paper – Typically 320‐400 grit paper is ideal to smooth the rough edges of the boards afterde‐
paneling.
Bench Vise – Works well for holding the board(s) while soldering.
Magnifying Glass – Can aid in seeing small details of the circuit board. A simple binocular magnifying
headset can also provide a great hands‐free solution and preserve depth perception.
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LEDs (polarity and position must be observed – read carefully)
These specific red, yellow and green LEDs were chosen to offer a single component solution for board
indicators. Each LED has a built‐in current limiting resistor and needs no other components added for
proper operation. You can add the red, yellow and green LEDs in any combination, in any location you
choose.
ONLY THESE RED, YELLOW AND GREEN LEDS – OR AN EQUIVALENT PART WITH INTERNAL RESISTOR ‐
CAN BE INSTALLED ON THE DIN / DOUT POSITIONS. AN LED WITH NO RESISTOR CAN NOT BE USED IN
THESE POSITIONS AS IT WILL FLOW TOO MUCH CURRENT AND MAY COMPROMIZE DATA INTEGRITY.
You can mix and match colors as you wish, however the ‘standard’ colors were chosen as:
DIN – Data Receiving – Yellow (reminiscent of yellow/green LEDs on most network jacks)
PWR – Power – Red – (LED is on solid whenever power is present, generally appears brighter than the
flashing LEDs, so it was paired with a color which generally appears ‘dimmer’ to human vision)
DOUT – Data Transmitting – Green (reminiscent of yellow/green LEDs on most network jacks). With a
‘green light blinking’, you should have output to the nodes.
SIG – PIC Signaling – Red (again chosen as a color which appears ‘dimmer’ to human vision)
A blue LED is also available. However, it should ONLY be used in the PIC signal (SIG) led spot. It draws
too much power for use in the DIN / DOUT positions and will be very bright in the PWR position.
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To add LEDs simply insert the colors of your choice in the spaces you wish to use. The long lead should
be on the ‘input’ side of the board for ALL LEDs (side with test switch and ICSP holes/header) and
inserted through the round solder pad. The short lead should go on the ‘output’ side of the board,
through the square solder pad.
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Magnetic Test Switch – nonpolar
The magnetic test switch is a way to evoke the µSC test function without physical contact of the circuit
board. This allows robust waterproofing – or even complete encapsulation of the board.
Attach the magnetic reed switch by first building two small domes of solder on the switch mounting
pads.

Grip the switch with a pair of tweezers, small pair of needle nose pliers, or other suitable tool.
Align the switch with the silk screen outline marked “TEST SW” and place one switch lead on top of the
solder dome.
Use your soldering iron to melt the solder dome and encapsulate the switch lead. Applying gentle
downward pressure will insure the switch rests firmly against the circuit board.
Remove the soldering iron and allow 2‐3 seconds for the solder to cool while maintaining downward
pressure and alignment of the switch with the tool.
Make any final adjustments to the switch position and repeat the downward pressure / lead
encapsulation process with the opposite switch lead.
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6 Socket ICSP (Programming) header (Special method required, please read carefully)
Under normal circumstances, the 6 Socket ICSP header should not be needed as the plated circuit board
holes have proven to withstand over 200 programming / PIC flash cycles. The small risk associated with
installing the header is where the input wires cross over the header solder pins. Care should be taken to
insure there are no sharp edges in this area which could cut or chafe the input wires, and that excess
insulation is not stripped from the wires which could then allow a short circuit with the ICSP header.
The following procedure is recommended to minimize this issue:
Prepare the ICSP socket by trimming the leads to 1/16” (the thickness of the circuit board) or slightly less
with a pair of side cutters.

Insert the ICSP socket in the circuit board and align with the silk screen outline
Solder the pins from the back side of the board, applying heat long enough to allow the solder to wick
into the hole and surround the header pin.
Withdraw the soldering iron quickly to avoid a sharp tip on the remaining solder.
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A small depression of solder is acceptable, as is a small dome of solder. However, under no
circumstances should there be a sharp point of solder or a sharp exposed lead of the header at this
location. Extra care should be taken when installing the input wires to insure bare wire is not exposed
where it could contact the solder domes.

Finish by cleaning any excess solder flux from around the soldered area.
(Positions 1, 2, and 3 shown as an example. Note pins of positions 4, 5, and 6 are slightly below the
surface of the board. Solder all 6 positions for a complete board.)
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3. Programming the uSC ‘from the beginning’ requires basic steps:
Download and Install MPLAB X
Configure the PICKit programmer for use with MPLAB (if you have previously been using PICKit
bootloader)
Configure MPLAB X IDE for use with PIC24F08KL200
Load Hex file to MPLAB IDE
Flash PIC Chip and confirm results

Download MPLAB X IDE
http://www.microchip.com/mplabx/
(if needed, you may also download the latest Falcon Firmware for µSC and Falcon Smart String Grouping
Software from the wiki main download page http://falconchristmas.com/wiki/index.php/Main_Page)
Extract the MPLab zipped folder and run the installation utility – ‘MPLABX‐v2.10‐windows‐installer.exe’
*Note the “V2.10” may be replaced with a later version
Accept license agreements
In the “Select Programs” window which opens as part of the install:
Be sure MPLAB X IPE (Integrated Programming Environment) is selected.
You can unselect MPLAB X IDE (Integrated Development Environment) if you do not plan to do program
development.
Finish setup.

Configure PICKit programmer for use with MPLAB (simple one time or permanent methods)
Simple one time use:
Hold down the PICKit button then plug the dongle into the USB port
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Permanent (until reverted back to PICKit mode)
Plug in PICKit programming dongle to USB port
Open PICKit Programming software
Click: Tools > Revert to MPLAB mode.
After a few moments a window should appear indicating “PICKit converted to MPLAB mode – Exiting
GUI”
(To switch back to PK3 operation, follow the same steps, but in the PICKit 3 software, click Tools >
Download PICKit Operating System and select the OS hex file which should be “PK3OSV020005.hex” or
similar)
Configure MPLAB X IDE for use with PIC24F08KL200
Plug PICKit programming dongle which has been set for MPLAB mode into USB port
Open MPLAB IPE
Set ‘Family:’ to ’16‐bit MCUs (PIC24)’
Set ‘Device:’ to ‘PIC24F08KL200’
‘Tool:’ should read PICKit[N] S.No : [XXXXXXXXXXX] (where N is 2 or 3 for the respective PICKit and the
X’s are your serial number)
Click ‘connect’ you should see a message ‘Downloading Firmware…’ and ‘Downloading RS…’
If a ‘Caution’ pops up warning of 5.0 and 3.3V device compatibility read the warning and click ‘OK’
Choose: Settings > Advanced Mode
Enter the password (default is ‘microchip’, you can change if you wish and select ‘remember’ if you
wish…which will make future login much more simple) then Click > Log on
A set of menu items will appear on the left edge of the window
Select ‘Power’
Confirm VDD is set to 3.25V
Check ‘Power Target Circuit from Tool’
Select ‘Operate’
Click File > Import Hex, navigate to your hex file location, choose it and OK
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Programming
Insert the gold plated leads of the 6 pin male‐to‐male header in the PICKit3 6‐pin socket. The short tin
plated leads will be exposed after insertion creating a male 6‐pin header.

Insert the male pins into the µSC board holes, be sure to align pin 1 of the programmer, indicated with a
white triangle (blue arrow) with ‘hole 1’ of the board, indicated with a square solder pad, white square
surrounding the pad and the numeral “1” on both sides of the board (red arrow).
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Apply slight pressure to twist the board into contact with the pins and click “program” on your
computer. Often, the weight of the PICKit programmer itself will be enough to insure contact with the
board holes.
If installed, you should see the PWR LED illuminate, DOUT LED may flash during the process and the SIG
LED will blink.
At the end of the process, MPLab will cycle power to the PIC and if the SIG LED has been installed, you
should then see the ‘standard’ start up routine which consists of fast blinking for one second, a one
second pause with the LED off, and a series of one second flashes to indicate the firmware version. One
flash = Firmware V1, two flashes = V2, etc.
MPLab IPE should also confirm ‘Program Successful’ in the ‘Output’ window. As a second confirmation,
you can click ‘Verify’ in the functions bar and confirm the output window displays ‘Verify Complete’.
The firmware has now been flashed to your µSC PIC chip and it is ready for channel programming using
Falcon Utility V 1.0.11 or later.

If MPLab shows “Program Failed”, the most likely cause is the PICKit pins failing to make adequate
contact with the board holes. Confirm the pin alignments detailed above, apply slightly more pressure
to the PICKit and retry the programming sequence.
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4. Removing Boards from the Array
If you ordered more than one µSC board, it likely came in a group or array. The boards were sent this
way to facilitate slightly easier handling and quicker / easier installation of optional components.

To remove the boards, carefully bend the array along the pre‐formed score lines. It is generally easiest
to break the end‐to‐end score lines first as they are shorter than the side‐to‐side score lines. You can
also flex the entire board to help weaken the score lines while you have the extra leverage of all boards
still attached. However, use extra caution when separating boards attached ‘end‐to‐end’ as the strain
relief holes also slightly reduce the strength of the board at that location. Gentle back‐and‐forth
bending typically works best.
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Once separated into 1x5 ‘sticks’, sanding (detailed below) can be performed on the rough ends to save a
bit of time versus sanding all the board ends individually. Once the end is smooth, break the side‐by‐
side joint to separate individual controllers and sand the newly separated edges if desired. Again, you
can weaken the scores by pre‐bending the entire stick to take advantage of leverage.

Separation may leave a slightly roughened edge where the boards were joined. This does not affect the
performance of the board, however if you wish to clean up the edge, a single 6 – 8 inch long pass across
320 – 400 grit sand paper will quickly smooth down any loose fibers and roughness.
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5. Attaching Leads
Take a moment to familiarize yourself with the layout of the board. The input and output configuration
is marked on both the front and back side of the board as detailed below:
Input Side – Back Silk Screen
O – Orange lead of the Cat 5 (aka Input Data A, or Data 1)
WO – White / Orange Tracer lead of the Cat 5 (aka Input Data B, or Data 2)
+IN – Positive voltage Input (5‐16 VDC)
‐IN – Ground / Negative Input

Output Side – Back Silk Screen
‐OUT – Ground / Negative Output
+OUT – Positive voltage Output (5‐16 VDC, follows Input V)
DATA OUT – Data Output to Nodes
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For convenience, the leads are also marked in silkscreen on the front of the circuit board.
Input Side – Front Silk Screen
O – Orange lead of the Cat 5 (aka Input Data A, or Data 1)
W – White / Orange Tracer lead of the Cat 5 (aka Input Data B, or Data 2)
P – Positive voltage Input (5‐16 VDC)
G – Ground / Negative Input

Output Side – Front Silk Screen
GND – Negative / Ground Output
PWR – Positive voltage Output (5‐16 VDC, follows Input V)
DAT – Data Output to Nodes
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To attach the leads, remove approximately 1 inch of outer covering / insulation from the wire bundle.
Remove any inner liner or tin foil as well (Cat 5). If desired, slide a piece of heat shrink tubing over the
wire bundle at this time.

Strip approximately 1/4 inch of insulation off the wire to be soldered and group the wires (if needed) by
twisting the strands together. Insure the insulation of the grouped wires is aligned as evenly as possible
so no bare wire will be exposed outside the solder pad outline. (inset and magnified box)
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Tin the twisted wires with solder being sure to minimize any melting of the wire insulation. Finally, trim
the exposed wire leads to approximately 1/8 inch length.

Tin the board solder pads with a small amount of solder to leave a gently rounded bump.
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Starting with the data wires, run the wire through the strain relief hole, position the exposed wire in the
center, or slightly inboard of the solder pad. Ideally, the wire insulation will extend over the edge of the
solder pad slightly. (inset) Apply gentle downward pressure with a suitable tool … small screwdriver,
wooden popsicle stick, tweezers, etc. Build a small drop of solder on the tip of your iron and touch that
drop to the pad/wire.

The pre‐placed solder on the board and wire should melt in a fraction of a second and encapsulate the
wire. Once this is complete, immediately remove the soldering iron and allow a few seconds for the
solder to cool down and secure the wire. If heat is applied to the wire for an extended period, the
insulation may begin to melt exposing additional wire. If this happens, either remove and re‐solder the
wire or insure the melted insulation does not allow bare wire contact with other circuit board pins such
as LEDs or the 6 socket header.
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Repeat this attachment process for each of the wires in turn. When complete with both input and
output wires, clean the board with a suitable flux removing solvent. Inspect each of the wires to insure
the insulation extends at least as far as the white outline on the solder pad, (red dashed line) or
preferably slightly beyond the outline and onto the solder pad itself. Also insure there are no ‘solder
bridges’ between adjacent pads. The white silkscreen pad outline should be clearly visible between the
pads. (blue arrows)
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If you added heat shrink tubing prior to starting the job, slide it into position and apply heat to complete
the shrinking process. Repeat this process as needed for other wire attachments to the board.
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6. Programming Channel Number
Like any string controller, a valid channel range needs to be programmed into the µSC before use.
This requires use of Falcon String Grouping Software (SGS) V1.0.11 or higher which can be
downloaded from the wiki main page http://falconchristmas.com/wiki/index.php/Main_Page
Extract the .zip file and install the grouping software to your computer. Once installed, insure that
no other sequencers or programs sending node data to the dongle (Light Show Pro,
Nutcracker/Xlights, Vixen, etc) are running, then open the grouping software.
Confirm ‘Method’ is correct (either ‘Serial’ for a USB dongle, or ‘EtherDongle’ for an Ethernet
connected dongle) and ‘Com Port’ is correct. Also, confirm your dongle is connected to the
computer and the hub is connected to the dongle – with all devices having power and
communicating.
** Note: Beyond this step there are multiple options for setting up the controller. This manual will
only address the most basic method with the expectation a user performing an advanced setup
would also have advanced knowledge of the process. Also note, for SGS V1.0.11, using ‘V4
Controller’ will also work for µSC programming.
To begin the process, click ‘Add V4 Controller’ which should add a new ‘V4’ controller to the
‘Controllers’ List. (You can also highlight and click ‘Remove’ on any controllers you do not need)
With the new ‘V4’ controller highlighted, multiple parameters can be selected on the right side of
the screen. The most basic options are pre‐selected and do not need to be changed. However, you
may wish to change variables such as Description, Channel Number, Device Type, Grouping, etc to fit
more advanced uses.
For the INITIAL program of the µSC you will need to click the check box for ‘Program All SSC on Hub’,
and insure NO other string controllers are plugged in – only the controller you wish to program. (For
future programming, the controller can be addressed by the unique start channel you program at
this time.)
Connect the µSC to the hub and insure the proper boot up sequence is displayed on the µSC
indicator LEDs (if installed) The PWR LED should be on, and the SIG LED should blink the start‐up
code, then remain off. Only the PWR LED will remain on.
Click ‘Program’ on the SGS and ‘OK’ on the warning pop‐up once you have confirmed conditions
mentioned. Immediately after clicking ‘OK’ you should see a short, and somewhat dim blink on both
the DIN and DOUT LEDS. The SIG LED will then blink a rapid sequence of flashes for 1 second.
Additionally, if nodes are connected to the µSC, you should see a Red / Green / Blue / Pink ‘rainbow’
illuminate on the nodes. If the process is not successful, refer to ‘Troubleshooting’.
The µSC is now programmed and ready to receive data from a sequencing program at the channel
number you just assigned. You can save the ‘Controllers’ list if needed and exit SGS.
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7. Test Mode
Test Mode is a method for sending basic color data to the nodes. This can be useful in evaluating
data integrity, transmission quality, node operability, etc. Test Mode can also be used to
troubleshoot node operation by helping to determine if an issue lies upstream of the µSC (ie – Test
Mode works, but data sent from the hub does not) or downstream of the µSC (ie the nodes also
show issues during Test Mode, too). Test mode can even be used to create a ‘Zombie’ or
autonomous string controller – as the ‘test patterns’ of node data are generated directly by the µSC
and displayed on the nodes – without the need for a central ‘brain’ or hub sending data. Test Mode
for the µSC can be evoked by different methods depending on the options installed.
Magnetic Reed Switch
On boards with a magnetic reed switch installed (red, rectangular component installed in the ‘TEST
SW’ space, shown below), applying a magnet to the reed switch generate a test pattern at the node
data output. If input data was being sent, test mode will automatically suspend any input data
processing and generate the test pattern at the data output. Display of input data will resume when
you exit test mode by removing the magnet.
Proximity of the magnet required to enter test mode will vary with the strength of the magnet and
the orientation relative to the reed switch. A low power magnet may need to be relatively close – ie
1/8 to 1/4 inch, however a strong magnet can evoke test mode several inches away.
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Boards with no Magnetic Reed Switch
If no reed switch has been installed, it is still possible to evoke test mode. A jumper* installed
between pins 2 and 6 of the ICSP header will evoke test mode in the same manner as the magnetic
reed switch. i.e. ‐ test mode will automatically suspend any input data processing and generate the
test pattern at the data output. Display of input data will resume when you exit test mode by
removing the jumper.
*Note – A solid conductor can be used for the jumper, however it is preferable to use a resistor with
a value of approximately 1K to 4.7K, to minimize the possibility of damage from any accidental short
circuit.
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8. Troubleshooting µSC Indicator LEDs
LED Indications

Possible Causes

Possible Solutions

1. PWR on, SIG blinks rapidly
for approximately one second,
pauses one second, blinks
firmware version code, then
stops and remains off

Normal start‐up when power is
first applied to properly flashed
board. DIN and DOUT LEDs may
also start to blink if data is
actively applied

n/a

2. DIN Flashing, SIG flashing,
PWR on, DOUT flashing

Normal operation when actively
receiving and transmitting data.

n/a

3. All LEDs off

No power / no input to µSC

Check connections at hub and
any input cable connections,
check hub fuse, check any cable
/ connectors between hub and
µSC, check hub power supply
and supply ‐to‐hub connections.

4. DIN Flashing, PWR off, SIG
off, DOUT off

Data input from board, but no
power to µSC

Check hub and input cable
connections, check hub fuse,
check any cable / connectors
between hub and µSC

5. Normal Start‐up Sequence,
when data transmission starts,
DIN flashing, SIG begins
repeating ‘start up’ sequence in
a continual loop, PWR remains
on solid, no DOUT

µSC has been loaded with
firmware (start‐up sequence is
correct) but has not been flashed
with channel number. PIC goes
into start‐up loop.

Use Falcon Programming Utility
V 1.0.11 or later to program valid
channel number range into PIC.
µSC should confirm successful
programming by showing
‘rainbow’ pattern on nodes.

6. PWR on, DOUT on solid
and/or no SIG flashing for one
second when power is applied.

PIC firmware is not programmed
correctly / PIC is blank.

Program PIC with Falcon
Firmware for µSC

(If nodes not working, see
below)
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7. Normal Start‐up Sequence
on µSC, but no µSCs of a group
will accept String Grouping
Software (SGS) channel
program.

8. Normal Start‐up Sequence
on µSC, but individual µSC will
not accept String Grouping
Software (SGS) channel
program. (but others do)

Error in setup of computer,
dongle, hub, SGS or connection
to µSC.
SGS should be V 1.0.11 or later

Refer to respective
manufacturers instructions to
confirm set up of computer, SGS,
dongle, hub, etc.
Can attempt to re‐flash µSC
firmware, though normal start‐
up sequence should confirm
valid firmware.

Incorrect input wiring polarity,
open contact in input wiring,
output wiring contact/polarity
issue (causing nodes not to flash
‘confirm’ rainbow, malfunction
on µSC board.

SGS should be V 1.0.11 or later

Observe the DIN, SIG and DOUT
LEDs at the instant the ‘program’
command is sent (immediately
when clicking ‘OK’ in the
‘warning’ pop‐up) You should
observe a brief (0.5 ms) flash on
the DIN and DOUT LEDs,
followed by a 1 second rapid
blinking sequence of the SIG LED.
If nodes are connected, a red,
green, blue, pink rainbow should
confirm success.
If no DIN/DOUT and SIG blinking
sequence is witnessed, confirm
polarity and conductivity of all
input connectors and wiring to
the µSC. (Note – you can
transmit sequence data to the
non‐channel‐programmed µSC
to check input connectivity. If
correct, you should observe the
response described in Condition
5.
If DIN/DOUT and SIG blinking
sequence is witnessed, confirm
polarity and conductivity of all
output connectors and wiring to
the µSC.
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9. PWR flashing intermittently,
dim, or flickering ‐ may be
accompanied by SIG flashing
with each new ‘on cycle’ of
PWR

Intermittent power to µSC or
high resistance input power
connection to µSC

Check hub and input cable
connections

10. DIN Flashing, SIG flashing,
PWR on, DOUT flashing, [ie
normal operation] – but nodes
not working

DOUT line open connection.

Evoke test mode through jumper
or magnet.

Or
Nodes wired incorrectly
Or
Sequencer transmitting ‘black’
(all nodes off – or 0, 0, 0 RGB
color)

Nodes NOT lighting in test mode
would indicate a connection
issue between the µSC and
nodes. Check:
Output solder connections

Or

Any connectors on the output
line

Bad first node (rare)

Node wiring sequence/polarity
Node input / output sides are
correct.
If still not working, check µSC
with known working node string.
If known good string works, it
may indicate a bad first node on
the non‐lighting string.
Nodes ARE lighting test mode
confirms correct wiring, good
connections to the nodes, and
µSC output, but suggests
sequencing program is
transmitting ‘black’ or ‘all off’ (all
nodes to 0,0,0 RGB) signal
(particularly notable in Light
Show Pro). Close / restart
sequencer, or insure a visible
color is being transmitted.
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11. DIN flashing, SIG flashing,
PWR on, DOUT off

µSC is receiving data and PIC is
processing data, but µSC not
transmitting data at the output
stage.

Program PIC with known good
Falcon Firmware, cycle power
and/or confirm normal program
/ startup sequences. If issue
persists replace µSC

12. DIN, SIG and DOUT flashing
intermittently, PWR on solid.
Nodes respond slowly or with
jerky fades/ramps/show
sequences, but correct colors

DIN, SIG and DOUT LED flashing
is indicative of frame rate.
Intermittent flashing means
intermittent frame rate, lagging
or ‘bursts’ of data reception.

Confirm show computer is not
lagging or stalling while
processing data. Confirm no
additional programs running in
background (such as virus scan,
video, etc)– if applicable

13. DIN, SIG and DOUT flashing
evenly, but slowly. Nodes
respond slowly and with jerky
fades/ramps

DIN, SIG and DOUT LED flashing
is indicative of frame rate. Slow
uniform flashing = slow uniform
frame rate.

Confirm show computer is not
lagging or stalling while
processing data. Increase frame
rate of sequencer if applicable.

14. DIN, SIG and/or DOUT
flashing intermittently. PWR on
solid and at normal brightness.
Nodes respond with incorrect
colors, show rainbows, or
erratic on/off nodes

Intermittent data reception at
µSC, data is erratic.

Check hub and µSC data input
connections for intermittent
contact, loose/broken wires, etc.

15. DIN, SIG, and DOUT
Intermittent data reception at
flashing normally. PWR on solid nodes.
and normal brightness. Nodes
respond with incorrect colors,
show rainbows, or erratic
on/off nodes

Check any connectors and data
lines between µSC and nodes for
intermittent contact.
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Insure data line is as short as
practical and not near a source
of electrical interference (RF
transmitter, electric motor, coils
of power wires, etc)
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If you believe you may have accidentally shorted the output wires, some possible conditions are listed
below:
Vin / Vout shorted to GND – Possible blown hub fuse, (indicated by PWR LED off on µSC) no damage to
µSC
DOUT shorted to Vin/Vout – Possible damage to node if connected and Vin >=5.5V, no damage to µSC
DOUT shorted to GND – No damage to node, no damage to µSC
In summary – shorted wires may have the possibility of blowing a fuse on the hub, or damaging a node,
though due to the robust nature of the µSC design with MOSFET driver output, no damage should occur
to the µSC board itself.
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9. General and Electrical Specifications
Voltage Input: 5‐16VDC
Voltage Output to Nodes: Same as Vin
Voltage Output on Data Line: 5V square wave across 5‐16V input range
Controller Power Consumption:
Maximum consumption with 4 indicator LEDs installed
Idle (on, but not transmitting data) ‐ 23mA
Full Tx mode ‐ 26mA
Minimum consumption with basic board, no indicator LEDs installed
Idle (on, but not transmitting data) ‐ 9mA
Full Tx mode ‐ 10mA
Controller‐to‐Node Data Tx Distance: Always keep as short as practical, realistically 10‐
20 feet, stress tested at 90 feet.
Node Compatibility: (Note – Insure µSC output voltage is compatible with node Vin)
TM1804 ‐ Confirmed
TM1809 – Confirmed
INK1002 ‐ ?
INK1003 ‐ ?
WS2811 ‐ Confirmed
WS2812 ‐ Likely
WS2812B ‐ Likely
Pixabulb (WS2811) ‐ Likely
WS280X ‐ NO (requires additional clock signal this controller does not transmit)
Maximum number of nodes controlled: 150 (Limited by PIC RAM memory)
Overall dimensions ‐ 1.240" long x 0.690" wide
(slightly shorter than an SD memory card and under 3/4 of the width)
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10. Revision History
Version 1.0

Original Document

Version 1.1

‐Created this version/revision tracking table
‐Updated cover page photo to show some optional components
‐Corrected link to MPLab software download (http://www.microchip.com/mplabx/)
‐Added hyperlinks to main sections
‐Add Section on Test Mode function
‐Minor revisions of wording, spacing, text alignments, etc

Version 1.2

‐Added current draw electrical spec for basic controller with no LEDs
‐Added pictures of board array denoting de‐paneling order
‐Expanded description of test mode
‐Added section to show typical use of µSC
‐Added ‘µSC with blank channels’ behavior to troubleshooting guide
‐Minor revisions of wording, spacing, text alignments, etc

Version 1.3

‐Expanded Channel Programming Section
‐Added links for firmware and channel programming software download

Version 1.4

‐Disambiguation of title to clarify revisions of this document separated from the
document being for µSC V1
‐Added ‘pre‐bending’ tip for depanelization
‐Added ‘Tools Required for Assembly’ Section
‐Added µSC/Node voltage compatibility note in S.9 (thanks JerryPlak!)
‐Minor revisions of wording, spacing, text alignments, etc

Version 1.5

‐Added ‘Condition Numbers’ to Troubleshooting guide
‐Added µSC will not accept channel programming to Troubleshooting guide
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